IBM InfoSphere Information Server
Version 9 Release 1

Connectivity Guide for IBM InfoSphere
Change Data Capture

IBM
## Contents

<table>
<thead>
<tr>
<th>Chapter 1. Overview</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM InfoSphere Change Data Capture overview</td>
<td>1</td>
</tr>
<tr>
<td>CDC Transaction stage overview</td>
<td>1</td>
</tr>
<tr>
<td>Flow of change data in a CDC Transaction stage job</td>
<td>2</td>
</tr>
<tr>
<td>Limitations</td>
<td>3</td>
</tr>
<tr>
<td>Software prerequisites and supported installation topologies</td>
<td>4</td>
</tr>
<tr>
<td>Chapter 2. Configuring the software for change data capture</td>
<td>9</td>
</tr>
<tr>
<td>Configuring InfoSphere CDC</td>
<td>9</td>
</tr>
<tr>
<td>Configuring access to ODBC data sources</td>
<td>10</td>
</tr>
<tr>
<td>Configuring access to ODBC data sources</td>
<td>10</td>
</tr>
<tr>
<td>Testing database connections by using the ISA Lite tool</td>
<td>11</td>
</tr>
<tr>
<td>Setting the library path environment variable</td>
<td>11</td>
</tr>
<tr>
<td>Chapter 3. Setting up replication in the InfoSphere CDC Management Console</td>
<td>15</td>
</tr>
<tr>
<td>Chapter 4. Developing a job that processes replicated data from InfoSphere CDC</td>
<td>17</td>
</tr>
<tr>
<td>Generating a template for the job</td>
<td>17</td>
</tr>
<tr>
<td>Setting up target tables for the job</td>
<td>18</td>
</tr>
<tr>
<td>Record format for change data records</td>
<td>18</td>
</tr>
<tr>
<td>bookmark record format</td>
<td>21</td>
</tr>
<tr>
<td>Configuring the CDC Transaction stage to read change data from InfoSphere CDC</td>
<td>22</td>
</tr>
<tr>
<td>Supported data type conversions</td>
<td>23</td>
</tr>
<tr>
<td>Adding and configuring additional stages</td>
<td>24</td>
</tr>
<tr>
<td>Configuring the target database stage to write change data</td>
<td>25</td>
</tr>
<tr>
<td>Compiling the job</td>
<td>26</td>
</tr>
<tr>
<td>Chapter 5. Starting the subscription and running the job</td>
<td>27</td>
</tr>
<tr>
<td>Chapter 6. Monitoring the status of the job and the subscription</td>
<td>29</td>
</tr>
<tr>
<td>Chapter 7. Ending the subscription</td>
<td>31</td>
</tr>
<tr>
<td>Chapter 8. Example: Applying change data by using a CDC Transaction stage</td>
<td>33</td>
</tr>
<tr>
<td>Setting up source and target tables for the example</td>
<td>33</td>
</tr>
<tr>
<td>Setting up replication</td>
<td>34</td>
</tr>
<tr>
<td>Generating a template for the job</td>
<td>37</td>
</tr>
<tr>
<td>Importing and configuring the job</td>
<td>38</td>
</tr>
<tr>
<td>Starting the subscription and running the job</td>
<td>41</td>
</tr>
<tr>
<td>Writing change data to the target database</td>
<td>42</td>
</tr>
<tr>
<td>Chapter 9. Troubleshooting</td>
<td>43</td>
</tr>
<tr>
<td>Value of DM_TIMESTAMP column in the target table is incorrect</td>
<td>43</td>
</tr>
<tr>
<td>Job fails to start automatically</td>
<td>43</td>
</tr>
<tr>
<td>Job fails while processing large records</td>
<td>44</td>
</tr>
<tr>
<td>Job fails with authentication failure message</td>
<td>44</td>
</tr>
<tr>
<td>Job fails with bookmark table missing message</td>
<td>45</td>
</tr>
<tr>
<td>Job fails with connection error message</td>
<td>45</td>
</tr>
<tr>
<td>Job fails with multiple bookmark links or no bookmark link error message</td>
<td>45</td>
</tr>
<tr>
<td>Job fails with table name for subscription not specified on link error message</td>
<td>46</td>
</tr>
<tr>
<td>Job fails with no response from server error message</td>
<td>46</td>
</tr>
<tr>
<td>Job fails with ODBC access failure message</td>
<td>46</td>
</tr>
<tr>
<td>Output data is truncated</td>
<td>47</td>
</tr>
<tr>
<td>Subscription stops while still in &quot;Starting&quot; state</td>
<td>47</td>
</tr>
<tr>
<td>Chapter 10. Frequently asked questions about the CDC Transaction stage</td>
<td>49</td>
</tr>
<tr>
<td>Chapter 11. Environment variables: CDC Transaction stage</td>
<td>51</td>
</tr>
<tr>
<td>CC_CDC_DEBUG</td>
<td>51</td>
</tr>
<tr>
<td>CC_CDC_SIMULATE_SOCKET</td>
<td>51</td>
</tr>
<tr>
<td>CC_IGNORE_TIME_LENGTH_AND_SCALE</td>
<td>51</td>
</tr>
<tr>
<td>CC_MSG_LEVEL</td>
<td>51</td>
</tr>
<tr>
<td>Appendix A. Product accessibility</td>
<td>53</td>
</tr>
<tr>
<td>Appendix B. Reading command-line syntax</td>
<td>55</td>
</tr>
<tr>
<td>Appendix C. How to read syntax diagrams</td>
<td>57</td>
</tr>
<tr>
<td>Appendix D. Contacting IBM</td>
<td>59</td>
</tr>
<tr>
<td>Appendix E. Accessing and providing feedback on the product documentation</td>
<td>61</td>
</tr>
<tr>
<td>Notices and trademarks</td>
<td>63</td>
</tr>
<tr>
<td>Index</td>
<td>67</td>
</tr>
</tbody>
</table>
Chapter 1. Overview

The CDC Transaction stage integrates the replication capabilities that are provided by IBM® InfoSphere® Change Data Capture (InfoSphere CDC) with the ETL capabilities that are provided by IBM InfoSphere DataStage®.

You can use these products together to perform real time, continuous replication with guaranteed delivery and transactional integrity in the event of failure.

Before using the CDC Transaction stage, you must first install InfoSphere CDC.

IBM InfoSphere Change Data Capture overview

IBM InfoSphere Change Data Capture (InfoSphere CDC) is a replication solution that captures database changes as they happen and delivers the changes to target databases, message queues, or an ETL solution, such as IBM InfoSphere DataStage.

The unit of replication within InfoSphere CDC is called a subscription. A subscription contains mapping details that specify how data in a source data store is applied to a target data store. A subscription can be scheduled to run at a specific time and stop when the updates to the target data store are complete, or a subscription can be set to run on a continuous basis to apply updates to the target data store as the changes occur. Subscriptions are created, configured, run, and monitored in the IBM InfoSphere Change Data Capture Management Console.

When a subscription runs, InfoSphere CDC captures changes on the source database. InfoSphere CDC delivers the change data to the target, and stores sync point information in a bookmark table in the target database. InfoSphere CDC uses the bookmark information to monitor progress of the InfoSphere DataStage job and determine restart points in the event of a failure. Synchronous updates to the bookmark information ensure that no updates are lost even if InfoSphere DataStage is not able to process all available updates. The bookmark information can also be used to determine the log retention policy for the source database.

InfoSphere CDC supports the following connection methods for writing change data to InfoSphere DataStage:

Direct connect
   Uses TCP/IP as the transport protocol to stream data from InfoSphere CDC to InfoSphere DataStage. When you use this method, you can configure options that cause the job to start automatically when you run the subscription.

Flat File
   Uses a file system to deliver source changes to InfoSphere DataStage.

This documentation describes how to use the direct connect method. For more information about using the flat file method, see the documentation for InfoSphere CDC. The documentation for InfoSphere CDC also contains additional details about using the direct connect method.

CDC Transaction stage overview

You can use the CDC Transaction stage in an IBM InfoSphere DataStage job to read data that is captured by IBM InfoSphere Change Data Capture (InfoSphere CDC) and apply the change data to a target database.
To use the CDC Transaction stage, you first set up replication in the InfoSphere CDC Management Console, and then use the InfoSphere CDC Management Console to generate a template for the InfoSphere DataStage job. You import the template into InfoSphere DataStage and modify the job, as required.

A basic CDC Transaction stage job includes the following stages and links:
- A CDC Transaction stage that specifies details about accessing your installation of InfoSphere CDC.
- The following output links from the CDC Transaction stage:
  - An output link for each table in the subscription. These output links transfer change data from InfoSphere CDC to another stage or to a target database. If a subscription contains more than one table, the changes for each table can follow a different path through the job.
  - A bookmark link that transfers bookmark information to a bookmark table in the target database.
- Additional stages, as required, that process the data.
- A database connector stage that specifies details about the target database.

For example, the following basic job contains a CDC Transaction stage, an output link, a bookmark link, and a DB2 connector stage that defines the details of the target database where the change data is applied:

![Diagram of CDC Transaction stage job](image)

A more complex job might include additional stages that process the data before it is delivered to the target database. For example, you can create jobs that perform the following types of actions:
- Transform change data by using prebuilt stages that are provided by InfoSphere DataStage
- Integrate data by performing lookups
- Apply custom business logic to the change data before delivering the data to a target database

**Flow of change data in a CDC Transaction stage job**

To understand how the CDC Transaction stage works, you should understand how data flows from the source database to the target database.

[Figure 1 on page 3](image) shows how data flows when IBM InfoSphere Change Data Capture (InfoSphere CDC) captures changes at a source database and uses IBM InfoSphere DataStage to deliver the change data to a target database.
On the computer where the source database is installed, the InfoSphere CDC service for the database monitors and captures the change.

InfoSphere CDC transfers the change data according to the replication definition.

The InfoSphere CDC for InfoSphere DataStage server sends data to the CDC Transaction stage through a TCP/IP session that is created when replication begins. Periodically, the InfoSphere CDC for InfoSphere DataStage server also sends a COMMIT message (along with bookmark information) to mark the transaction boundary in the captured log.

In the InfoSphere DataStage job, the data flows over links from the CDC Transaction stage to the target database connector stage. The bookmark information is sent over a bookmark link. For each COMMIT message sent by the InfoSphere CDC for InfoSphere DataStage server, the CDC Transaction stage creates end-of-wave (EOW) markers that are sent on all output links to the target database connector stage.

The target database connector stage connects to the target database and sends data over the session. When the target database connector stage receives an end-of-wave marker on all input links, it writes bookmark information to a bookmark table and then commits the transaction to the target database.

Periodically, the InfoSphere CDC for InfoSphere DataStage server requests bookmark information from a bookmark table on the target database. In response to the request, the CDC Transaction stage fetches the bookmark information through ODBC and returns it to the InfoSphere CDC for InfoSphere DataStage server.

The InfoSphere CDC for InfoSphere DataStage server receives the bookmark information, which is used for the following purposes:

- To determine the starting point in the transaction log where changes are read when replication begins. (The starting point in the transaction log is the ending point from the previous replication, if the replication ended successfully.)
- To determine if the existing transaction log can be cleaned up.

The bookmark is committed synchronously with the data, so even if the job fails, the bookmark information and the written data are consistent. If the job fails, replication begins at the point that is indicated by the bookmark, and there is no loss of data.

Limitations

Some limitations apply when you use the CDC Transactions stage to read change data from IBM InfoSphere Change Data Capture (InfoSphere CDC) and apply the change data to a target database.
LOB data type truncation

Large object (LOB) data is supported, but there is a maximum LOB size above which the content is truncated. You configure LOB truncation size in the InfoSphere DataStage Properties window of the IBM InfoSphere Change Data Capture Management Console when you configure the subscription.

Define a truncation size for LOB data that ensures that the total length of the output record does not exceed the size of the transport block that can pass between the stages of an IBM InfoSphere DataStage job. The size of the transport block is specified by the APT_DEFAULT_TRANSPORT_BLOCK_SIZE environment variable. By default, the value of this environment variable is 128 KB. You can increase the size of the transport block. However, increasing this size affects all links and might increase overall memory and disk usage.

For more information about specifying the LOB truncation size, see the InfoSphere CDC documentation.

Transactional integrity

If either of the following statements is true, the overall transactional integrity of the job is not guaranteed:

- Reject links are used on the target database connector stage of the job.
- The job does not process the data sequentially.

Encryption of sensitive data

Other than connection keys, data transferred between InfoSphere CDC and the CDC Transaction stage is unencrypted. SSL connections are not supported. To provide additional data security, use VPN or SSH tunneling.

Instance recreation

After creating an instance of InfoSphere CDC for InfoSphere DataStage, you cannot delete and recreate the instance without making subscriptions that use the instance unusable. By deleting the instance, you destroy the relationship between and source and target configuration for the subscription. If you destroy this relationship, you must delete the subscription and start again.

DDL awareness

Some versions of InfoSphere CDC do not support DDL awareness. Therefore, if a source table is dropped during replication, no error occurs for some InfoSphere CDC sources. The subscription and corresponding CDC Transaction stage job might continue to run even though the source table no longer exists.

Software prerequisites and supported installation topologies

Before using the CDC Transaction stage in an IBM InfoSphere DataStage job, you must install and configure the prerequisite IBM InfoSphere Change Data Capture (InfoSphere CDC) software. When you plan your installation, make sure that you use a supported installation topology.

Software prerequisites

You must install and configure the required IBM InfoSphere Change Data Capture (InfoSphere CDC) components.

For a list of supported software versions, see [www.ibm.com/support/docview.wss?uid=swg27020317](http://www.ibm.com/support/docview.wss?uid=swg27020317)

IBM InfoSphere Change Data Capture Access Server

Controls all non-command line access to the replication environment.
IBM InfoSphere Change Data Capture Management Console
Provides a user interface for configuring and monitoring replication.

IBM InfoSphere Change Data Capture for the source database
Monitors source tables for changes and sends change data to the replication engine.

InfoSphere CDC provides components that are compatible with each supported database. You install the InfoSphere CDC component that is compatible with the source database that you have installed. For example, if you are using IBM DB2® Database for Linux, UNIX, and Windows as the source database, you install InfoSphere CDC for DB2 for Linux, UNIX, and Windows.

The log retention policy for the source database must be set to retain logs.

IBM InfoSphere Change Data Capture for IBM InfoSphere DataStage
Processes changes delivered from InfoSphere CDC that can be used by InfoSphere DataStage jobs.

If you plan to use the auto-start feature to start InfoSphere DataStage jobs automatically, install IBM InfoSphere Information Server before you install InfoSphere CDC. Installing the software components in this order ensures that the InfoSphere CDC for InfoSphere DataStage server has access to the `dsjob` command during installation.

For more information about installing InfoSphere CDC, see the InfoSphere CDC documentation.

Supported installation topologies
You can install InfoSphere CDC components on the same computer, or you can design a topology that includes several different computers. The term computers refers to separate physical servers, logical partition (LPARs), or virtual machines.

Figure 2 on page 6 illustrates a topology with components that are installed as separately as possible on different computers. In this topology, InfoSphere CDC for InfoSphere DataStage is not installed on the same computer as InfoSphere DataStage. Although this topology illustrates what is possible, it has limitations because the auto-start feature is unavailable, and InfoSphere DataStage jobs must be started manually.
In Figure 2, the components are installed on the following computers. Unless otherwise noted, solid black arrows in the diagram represent TCP/IP connections. Solid gray lines represent database connections. Solid gray arrows represent InfoSphere DataStage links.

**Computer A**
- InfoSphere CDC Management Console

**Computer B**
- InfoSphere DataStage and QualityStage® Designer client
- InfoSphere DataStage and QualityStage Director client

**Computer C**
- InfoSphere CDC Access Server

**Computer D**
- InfoSphere CDC for the source database
- Source database

**Computer E**
- InfoSphere CDC for InfoSphere DataStage

**Computer F**
- InfoSphere DataStage
- Target DB Connector stage
- InfoSphere DataStage

**Computer G**
- Target database

Figure 2. Topology with separate components installed on many different computers

In Figure 2, the components are installed on the following computers. Unless otherwise noted, solid black arrows in the diagram represent TCP/IP connections. Solid gray lines represent database connections. Solid gray arrows represent InfoSphere DataStage links.

**Computer A**
- InfoSphere CDC Management Console

**Computer B**
- InfoSphere DataStage and QualityStage® Designer client
- InfoSphere DataStage and QualityStage Director client

**Computer C**
- InfoSphere CDC Access Server

**Computer D**
- InfoSphere CDC for the source database
- Source database

**Computer E**
- InfoSphere CDC for InfoSphere DataStage

**Computer F**
- InfoSphere DataStage

**Computer G**
- Target database

Figure 3 on page 7 illustrates a topology with components that are installed on shared computers. The auto-start feature is available, and the coexistence of client components on the same computer simplifies subscription and job monitoring.
In Figure 3, the components are installed on the following computers. Unless otherwise noted, solid black arrows in the diagram represent TCP/IP connections. Solid gray lines represent database connections. Solid gray arrows represent InfoSphere DataStage links.

Computer A
- InfoSphere CDC Management Console
- InfoSphere DataStage and QualityStage Designer client
- InfoSphere DataStage and QualityStage Director client

Computer B
- InfoSphere CDC Access Server

Computer C
- InfoSphere CDC for source database
- Source database

Computer D
- InfoSphere CDC for InfoSphere DataStage
- CDC Transaction stage
- Target DB Connector stage
- InfoSphere DataStage

Computer E
- Target database

If required, you can install all the software on a single computer.
Chapter 2. Configuring the software for change data capture

After installing InfoSphere CDC, you configure the software for change data capture before developing a job that uses the CDC Transaction stage.

Configuring InfoSphere CDC

After installing InfoSphere CDC, the installation program starts a configuration tool. You use the configuration tool to add and configure InfoSphere CDC instances for your environment. You must configure InfoSphere CDC for the source database and for the target (InfoSphere DataStage) before you can start replication.

Before you begin

Install InfoSphere CDC. For more information, see the InfoSphere CDC documentation.

About this task

This procedure describes the general steps that you must perform to configure InfoSphere CDC to work with the CDC Transaction stage. For more information about configuring InfoSphere CDC, see the InfoSphere CDC documentation that describes how to add and configure new instances.

Tip: If you plan to configure your job to start automatically when the subscription starts, ensure that the PATH environment variable contains the path to the dsjob executable file before you add the new CDC instances.

Procedure

1. Configure InfoSphere CDC for the source database. For example, if you are using IBM DB2 Database for Linux, UNIX, and Windows as a source database, you configure InfoSphere CDC for DB2 for Linux, UNIX, and Windows.
   a. On the computer where InfoSphere CDC for the source database is installed, start the InfoSphere CDC configuration tool (if it is not already running).
   b. Add a new instance of InfoSphere CDC.
   c. Specify configuration details about the instance, including the following settings:
      • For the Server Port, specify the port number that other servers will use to communicate with this instance of InfoSphere CDC for the source database. Write down the port number that you specify. You provide this port number when you specify access parameters for this data store in the Access Manager perspective in InfoSphere CDC Management Console.
      • Specify connection details for the database that contains the tables that you want to replicate.
   d. Start the instance.
2. Configure InfoSphere CDC for InfoSphere DataStage.
   a. On the computer where InfoSphere CDC for InfoSphere DataStage is installed, start the InfoSphere CDC configuration tool (if it is not already running).
   b. Add a new instance of InfoSphere CDC.

   Important: After creating this instance, you cannot delete and recreate it without making subscriptions that use the instance unusable.
   c. Specify configuration details about the instance, including the following settings:
      • For the Server Port, specify the port number that other servers will use to communicate with this instance of InfoSphere CDC for InfoSphere DataStage. Write down the port number that
you specify. You provide this port number when you specify access parameters for InfoSphere DataStage in the Access Manager perspective in InfoSphere CDC Management Console.

- Specify a password for the user named tsuser. Write down the password that you specify. You provide the tsuser ID and password when you specify connection parameters for InfoSphere DataStage in the Access Manager perspective in the InfoSphere CDC Management Console.

What to do next

After configuring InfoSphere CDC, you set up a new ODBC data source name (DSN) on the computer where InfoSphere DataStage is installed. For more information, see the topic about configuring access to ODBC data sources. The CDC Transaction stage uses ODBC to return bookmark information from the target database. You specify the ODBC DSN as a stage property when you configure the InfoSphere DataStage job.

Configuring access to ODBC data sources

To configure access to ODBC data sources, you must install database client libraries and include the path to these installed libraries in the library path environment variable. For more information about setting environment variables, see the topic about setting environment variables.

Procedure

1. Install database client libraries.
2. "Configuring access to ODBC data sources."

Configuring access to ODBC data sources

To use the ODBC data sources in a job, you must configure the ODBC driver and also the ODBC data source name (DSN) definitions.

Before you begin

- Install client libraries.
- Test the connection to the ODBC data source.
- On 64-bit Windows computers, make sure that you run the 32-bit version of the Microsoft ODBC Data Source Administrator C:\Windows\SysW64\odbcad32.exe, as InfoSphere Information Server is a 32-bit application. If you run the 64-bit version of the ODBC administrator application, the Netezza connector cannot to locate the specified data source name. If the ODBC administrator application is not accessible through the File menu by default, use the Windows Explorer to access the application.
- For more information about configuring ODBC connectivity in InfoSphere DataStage and configuring ODBC data source name definitions, see the IBM InfoSphere Information Server Planning, Installation, and Configuration Guide.

Procedure

1. Configure the ODBC DSN definitions.

Table 1. Configuring the ODBC data source name definitions

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNIX or Linux</td>
<td>Set the ODBCINI environment variable to point to the .odbc.ini file. The .odbc.ini file contains the ODBC DSN definitions.</td>
</tr>
</tbody>
</table>

**Note:** The ODBCINI environment variable is set in the dsenv script automatically as part of the InfoSphere Information Server installation process.
2. Add the path to the directory that contains the client libraries to the library path environment variable. The default path for client libraries is as follows:
   - On Windows, C:\IBM\InformationServer\ODBCDrivers. On the Microsoft Windows, the ODBC driver manager library is provided by the operating system. The location of the ODBC driver manager is automatically included in the PATH environment variable.
   - On Linux and UNIX, /opt/IBM/InformationServer/Server/branded_odbc/lib. The ODBC driver manager is included with InfoSphere Information Server.

3. On UNIX and Linux computers, to restart the server engine and the ASB Agent, enter the following command:
   ```
   cd Install_directory/Server/DSEngine/bin
   ./uv -admin -stop
   ./uv -admin -start
   cd Install_directory/ASBNode/bin
   ./NodeAgents_env_DS.sh
   ./NodeAgents.sh stopAgent
   ./NodeAgents.sh start
   ```

**Testing database connections by using the ISA Lite tool**

After you establish connection to the databases, test the database connection by running the IBM Support Assistant (ISA) Lite for InfoSphere Information Server tool.

For more information about the ISA Lite tool, see the topic about installation verification and troubleshooting.

**Setting the library path environment variable**

To apply an environment variable to all jobs in a project, define the environment variable in the InfoSphere DataStage and QualityStage Administrator. The values that are specified for the library path and path environment variables at the project or job level are appended to the existing system values for these variables.

**About this task**

For example, suppose that directory /opt/branded_odbc/lib is specified as the value for the library path environment variable at the project level. Directory /opt/IBM/InformationServer/Server/branded_odbc/lib, which contains the same libraries but in a different location is already in the library path that is defined at the operating system level or the dsenv script. In this case, the libraries from directory /opt/IBM/InformationServer/Server/branded_odbc/lib are loaded when the job runs because this directory appears before directory /opt/branded_odbc/lib in the values that are defined for the library path environment variable.

The name of the library path environment variable depends on your operating system.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Library path environment variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows</td>
<td>PATH</td>
</tr>
<tr>
<td>HP-UX</td>
<td>SHLIB_PATH</td>
</tr>
</tbody>
</table>
### Operating system Library path environment variable

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Library path environment variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM AIX®</td>
<td>LIBPATH</td>
</tr>
<tr>
<td>Other supported Linux and UNIX operating systems, and HP-IA</td>
<td>LD_LIBRARY_PATH</td>
</tr>
</tbody>
</table>

On Linux or UNIX operating systems, the environment variables can be specified in the dsenv script. InfoSphere Information Server installations on Windows operating system do not include the dsenv script.

### Setting the library path environment variable in the dsenv file

On Linux or UNIX operating systems, you can specify the library path environment variables in the dsenv script. When environment variables are specified in the dsenv script, they apply to all InfoSphere DataStage projects that run under the InfoSphere Information Server engine.

**Before you begin**

Install the client libraries.

**Procedure**

1. Log in as the root user.
2. Back up the $ISHOME/Server/DSEngine/dsenv script. $ISHOME is the InfoSphere Information Server installation directory (/opt/IBM/InformationServer by default).
3. Open the dsenv script.
4. Add the path to the directory that contains the client libraries to the library path environment variable.
5. To stop and start the InfoSphere Information Server engine, enter the following commands:
   ```bash
   bin/uv --admin --stop
   bin/uv --admin --start
   ```
6. To change directory to the ASB Agent home directory, enter the following commands:
   ```bash
   cd Install_directory/ASBNode/bin
   ```
7. To stop and start the ASB Agent processes, enter the following commands:
   ```bash
   ./NodeAgents.sh stopAgent
   ./NodeAgents.sh start
   ```

**Results**

After you restart the ASB Agent process, the InfoSphere Information Server domain services (WebSphere® Application Server) take approximately a minute to register the event.

### Setting the library path environment variable in Windows

On the Windows operating system, both the library path and PATH environment variables are represented by the PATH. For InfoSphere Information Server engine and ASB Agent processes to detect changes in the environment variables, the changes must be made at the system level and the InfoSphere Information Server engine must be restarted.

**Before you begin**

Install the client libraries.

**Procedure**

1. To edit the PATH system environment variable, click Environment Variable in Advanced System Settings, and then select PATH.
2. Click Edit, then specify the path to the directory containing the client libraries.
3. Click OK.
4. Restart the InfoSphere Information Server engine.
5. Restart the ASB Agent processes.
Chapter 3. Setting up replication in the InfoSphere CDC Management Console

You set up replication in the InfoSphere CDC Management Console to define how change data is captured and sent to the target. To set up replication, you add data stores for the source and target, add a new subscription, and map one or more tables to the target system.

**Before you begin**

Configure InfoSphere CDC Management Console.

**About this task**

This procedure describes the general steps that you must perform to set up replication in the InfoSphere CDC Management Console. For more information about setting up replication, see the InfoSphere CDC documentation. (When searching for information about adding data stores, note that the InfoSphere CDC documentation spells data store as one word, datastore.)

**Procedure**

1. Log on to the InfoSphere CDC Management Console. Enter the connection information that you specified for InfoSphere CDC Access Server during the installation.

2. In the Access Manager perspective, add data stores for the source and the target.
   a. In the Datastore Management tab, add a data store for the source database. Specify details about the data store, including the following settings:
      - For the server name, enter the host name of the computer where you installed InfoSphere CDC for the source database.
      - For the port number, enter the number that you specified when you configured InfoSphere CDC for the source database.
   b. Add a data store for the target, InfoSphere DataStage. Specify details about the target, including the following settings:
      - For the server name, enter the host name of the computer where you installed InfoSphere CDC for InfoSphere DataStage.
      - For the port number, enter the number that you specified when you configured InfoSphere CDC for InfoSphere DataStage.
      - For the connection parameters, specify the credentials for tsuser, the user that you created when you configured InfoSphere CDC for InfoSphere DataStage.
   c. Optional: In the User Management tab, add a new user. You can add a new user or use an existing one.
   d. In the Connection Management tab, assign a user to each data store.

3. In the Configuration perspective of the InfoSphere CDC Management Console, add a new subscription. A subscription contains mapping details that specify how data in a source data store is applied to a target data store.
   a. For the source, select the data store that contains the tables that you want to replicate.
   b. For the target, select the data store that you created for InfoSphere DataStage.

4. In the Configuration perspective of the InfoSphere CDC Management Console, use the Map Tables wizard to map one or more tables to the target, InfoSphere DataStage. When you run the wizard, make sure that you select the following options.
   a. In the Select Map Typing page, select InfoSphere DataStage.
b. In the Select InfoSphere DataStage Connection Method page, select **Direct Connect**.

c. In the Select Source Tables page, select the tables that you want to replicate.

d. In the InfoSphere DataStage Direct Connect page, select the type of record format to use for the change data.

**Single Record**

Both the "before image" (the record before the update) and the "after image" (the record after the update) are sent in a single record.

**Multiple Records**

The "before image" and the "after image" are sent in separate records.

After you have mapped a table to a target, the table is no longer available for another mapping within the same subscription.

5. In the Configuration perspective of the InfoSphere CDC Management Console, specify InfoSphere DataStage properties.

a. In the **Subscriptions** tab, right-click the subscription, and select **InfoSphere DataStage > InfoSphere DataStage Properties**. The subscription must be open for editing when you define these properties, or your changes are not saved.

b. In the Direct Connect area, specify the project name, job name, and connection key for the InfoSphere DataStage job. The connection key ensures that only the job with the correct connection key information is used by InfoSphere DataStage when receiving change data from InfoSphere CDC. You specify this connection key as a stage property when you configure the InfoSphere DataStage job.

c. Optional: If you want to configure the job to start automatically when the subscription starts, select **Auto-start InfoSphere DataStage Job**.

**Important:** For the auto-start function to work correctly, InfoSphere CDC must be able to load and execute the *dsjob* command and the dependent shared library. The path to this library must be specified in the library path environment variable on the computer where InfoSphere CDC for InfoSphere DataStage is installed.

On UNIX or Linux, you can view and modify the setting for this environment variable in the *dsenv* file. After setting this environment variable, source the *dsenv* file and then start the InfoSphere CDC for InfoSphere DataStage server to set these environment variables for the server. For example, issue one of the following commands to source the *dsenv* file:

```
$ . dsenv
```

or

```
$ source dsenv
```

Then issue the following command to start the InfoSphere CDC for InfoSphere DataStage server:

```
$ dmts64 -I <instance name>
```

The environment variables for the process, *dmts64*, are set as specified in the *dsenv* file.

Also, make sure that the process is executed by a user with the user privilege and permission to run the *dsjob* command. A user who is added to the primary group of the DataStage administrator primary group has the user privileges and the permission to the *dsjob* command.
Chapter 4. Developing a job that processes replicated data from InfoSphere CDC

After setting up replication in the InfoSphere CDC Management Console, you generate a template for the InfoSphere DataStage job, import the template into InfoSphere DataStage and QualityStage Designer, and configure the stages of the job.

Before you begin

- Make sure the prerequisite software is installed.
- Configure the software for change data capture.
- Set up replication in the InfoSphere CDC Management Console.

About this task

An InfoSphere DataStage job that processes change data from InfoSphere CDC includes the following stages:

- A CDC Transaction stage that specifies details about InfoSphere CDC.
- A database connector stage that specifies details about the target database.
- Zero or more stages that exist between the CDC Transaction stage and the database connector stage. These additional stages process the change data before delivering it to the final database connector stage.

To ensure transactional integrity, all stages in the job must run sequentially. Reject links are not supported.

Perform the following tasks to develop a job that uses a CDC Transaction stage.

Generating a template for the job

After creating a subscription in the InfoSphere CDC Management Console, you generate a template for the InfoSphere DataStage job. You can use the template as a starting point for the job and insert your own logic, or you can cut and paste parts of the job, such as the CDC Transaction stage, into another job.

Before you begin

Set up replication in InfoSphere CDC Management Console.

Procedure

1. Log on to the InfoSphere CDC Management Console.
2. Generate the template for the job:
   a. In the Subscriptions tab of the Configuration perspective, right-click the subscription, and click InfoSphere DataStage > Generate InfoSphere DataStage Job Definition. This option is available only after the subscription is correctly set up.
   b. In the dialog box that is displayed, browse to select the location for the .dsx file, and click Save.
3. Copy the .dsx file to a location that is accessible by the computer where InfoSphere DataStage and QualityStage Designer is installed.

What to do next

Set up target tables for the job

© Copyright IBM Corp. 2008, 2013
Setting up target tables for the job

Before configuring the InfoSphere DataStage job, you set up tables in the target database to hold the change data and bookmark information. The target database must contain a unique bookmark table for each subscription.

Before you begin

You must be authorized to create tables in the target database.

Procedure

1. Connect to the target database.
2. Create the target tables for storing the change data records. Use the appropriate format for either single record format or multiple record format. For more information, see “Record format for change data records.” To determine the format of the target tables, also consider the design of the job and the transformations that need to be done between the CDC Transaction stage and the target database connector stage. The change data that is output by the CDC Transaction stage includes the before and after images of the data, along with control columns. The control columns, which have the prefix `DM_`, provide additional details about the change data, such as when the change occurred and the type of operation that was performed. You can use these control columns to transform the data in subsequent processing stages, or you can simply drop the columns if they are not needed.
3. Create the bookmark table. Use the appropriate format for bookmark records. For more information, see “Bookmark record format” on page 21.

What to do next

Configure the CDC Transaction stage

Record format for change data records

InfoSphere CDC delivers change data to the CDC Transaction stage in either a single record format or a multiple record format. You select the type of record format to use when you set up the subscription.

Single record format

When single record format is specified, both the "before image" (the record before the update) and the "after image" (the record after the update) are passed in a single record.

The following example illustrates the format of the change data that is inserted in the target table when single record format is specified. In this example, the following SQL statements are issued on the source database:

```
INSERT INTO T01 VALUES(1, 'John')
UPDATE T01 SET NAME='Jack' WHERE ID=1
DELETE T01 WHERE ID=1
COMMIT
```

After these statements execute and the job runs, each record in the target table contains the "before image" and "after image" of the data.

Table 2. Example of change data that has a single record format

<table>
<thead>
<tr>
<th>DM_OPERATION_TYPE</th>
<th>BEFORE_ID</th>
<th>BEFORE_NAME</th>
<th>ID</th>
<th>NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>'I'</td>
<td></td>
<td></td>
<td>1</td>
<td>John</td>
</tr>
<tr>
<td>'U'</td>
<td>1</td>
<td>'John'</td>
<td>1</td>
<td>Jack</td>
</tr>
<tr>
<td>'D'</td>
<td>1</td>
<td>'Jack'</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
In this example, the table contains a record for each operation that was performed. The DM_OPERATION_TYPE column indicates the type of operation that was performed on the source table. The BEFORE_ID and BEFORE_NAME columns contain the data before the change, and the ID and NAME columns contain the data after the change.

**Multiple record format**

When multiple record format is specified, the "before image" and "after image" are passed in separate records.

The following example illustrates the data that is inserted in the target table when multiple record format is specified. In this example, the following SQL statements are issued on the source database:

```sql
INSERT INTO T01 VALUES(1, 'John')
UPDATE T01 SET NAME='Jack' WHERE ID=1
DELETE T01 WHERE ID=1
COMMIT
```

After these statements execute and the job runs, the target table contains separate records for the "before image" and "after image" of the data.

<table>
<thead>
<tr>
<th>DM_OPERATION_TYPE</th>
<th>ID</th>
<th>NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>'I'</td>
<td>1</td>
<td>'John'</td>
</tr>
<tr>
<td>'B'</td>
<td>1</td>
<td>'John'</td>
</tr>
<tr>
<td>'A'</td>
<td>1</td>
<td>'Jack'</td>
</tr>
<tr>
<td>'D'</td>
<td>1</td>
<td>'Jack'</td>
</tr>
</tbody>
</table>

In this example, the table contains one record for the INSERT operation that was performed, two records for the UPDATE operation, and one record for the DELETE operation. The DM_OPERATION_TYPE column indicates the type of operation that was performed on the source table. If the operation was an update, the DM_OPERATION_TYPE column contains either 'B' to indicate that the record contains the "before image" or 'A' to indicate that the record contains the "after image."

**Column definition for change data records**

Change data records include the following columns. The SQL types in this table are InfoSphere DataStage data types. The compatible native data types on the target database might differ depending on the target stage type or target database version. For example, some databases use the datetime data type to store data that InfoSphere DataStage stores in the Timestamp field. For more information, see the documentation for the target stage or the target database.

<table>
<thead>
<tr>
<th>Column name</th>
<th>Key</th>
<th>SQL type</th>
<th>Length</th>
<th>Nullable</th>
</tr>
</thead>
<tbody>
<tr>
<td>DM_SORTKEY</td>
<td>Yes</td>
<td>Numeric</td>
<td>20</td>
<td>Yes</td>
</tr>
<tr>
<td>DM_OPERATION_TYPE</td>
<td>Yes</td>
<td>Char</td>
<td>1</td>
<td>Yes</td>
</tr>
<tr>
<td>DM_TIMESTAMP</td>
<td>No</td>
<td>Timestamp</td>
<td>Not applicable</td>
<td>Yes</td>
</tr>
<tr>
<td>DM_TXID</td>
<td>No</td>
<td>Numeric</td>
<td>24</td>
<td>Yes</td>
</tr>
<tr>
<td>DM_USER</td>
<td>No</td>
<td>NVarChar</td>
<td>30</td>
<td>Yes</td>
</tr>
<tr>
<td>BEFORE_COL_NAME</td>
<td>Yes</td>
<td>Derived from source database</td>
<td>Derived from source database</td>
<td>Yes</td>
</tr>
<tr>
<td>COL_NAME</td>
<td>Yes</td>
<td>Derived from source database</td>
<td>Derived from source database</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Table 4. Column definition for change data records (continued)

<table>
<thead>
<tr>
<th>Column name</th>
<th>Key</th>
<th>SQL type</th>
<th>Length</th>
<th>Nullable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table notes:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1. This column is used only with the single record format. Omit this column definition for multiple record format.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. COL_NAME is the name of the column in the source table. The change data record includes a column with this name for each column in the source table. For example, if the source table contains two columns, DEPT and DEPTNO, the change data record for single record format includes the following columns:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• BEFORE DEPT</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• BEFORE DEPTNO</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• DEPT</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• DEPTNO</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The record format includes the following columns:

**DM_SORTKEY**
Contains an unsigned 64 bit integer, starting at 1, that is incremented for each output row. When multiple record format is specified, the value of this column is the same for both the "before image" and "after image." The CDC Transaction stage has its own counter and counts from 1 at every job run. When the value of this column reaches the maximum value for an unsigned, 64 bit integer, a warning is raised in the job log, and the value is set to 0.

**DM_OPERATION_TYPE**
Contains a single character that indicates the type of operation:
- I Insert
- D Delete
- U Update (in single record format)
- A "After image" of an update (in multiple record format)
- B "Before image" of an update (in multiple record format)

**DM_TIMESTAMP**
Contains the date and time of when the change was made on the source table. This column contains the value from the &TIMESTAMP (Record Modification Time) journal control field. By default, the value of DM_TIMESTAMP is changed to UTC timezone before the InfoSphere CDC for InfoSphere DataStage server passes the value to the target table. You can change this behavior by adding a system parameter to the InfoSphere CDC for InfoSphere DataStage data store. The system parameter must have the parameter name ds_output_timestamp_utc and the value false. For more information about adding a system parameter to a data store, see the InfoSphere CDC documentation.

**DM_TXID**
Contains the transaction ID of the transaction with the update. This column contains the value from the &CCID (Commit Cycle ID) journal control field.

**DM_USER**
Contains the user ID that changed the source table. This column contains the value from the &USER (Record Modification User) journal control field.

**BEFORE_COL_NAME**
For single record format, contains the "before image" of the data. If the value of DM_OPERATION_TYPE is I (for Insert), this column contains NULL.

**COL_NAME**
For single record format, contains the "after image" of the data. If the value of DM_OPERATION_TYPE is D (for Delete), this column contains NULL.
For multiple record format, contains the "before image" or "after image" of the data. The value of the DM_OPERATION_TYPE column indicates whether this column contains the "before image" or "after image."

For more information about journal control fields, see the InfoSphere CDC documentation.

**Bookmark record format**

The bookmark table in the target database stores sync point information. InfoSphere CDC uses the bookmark information to monitor progress of the InfoSphere DataStage job and determine restart points in the event of a failure. The target database must contain a unique bookmark table for each subscription.

The bookmark table consists of two columns: An ID that is used to uniquely identify the record, and the bookmark block.

<table>
<thead>
<tr>
<th>Column name</th>
<th>Key</th>
<th>SQL type</th>
<th>Length</th>
<th>Nullable</th>
</tr>
</thead>
<tbody>
<tr>
<td>DM_KEY</td>
<td>Yes</td>
<td>Smallint</td>
<td>Not applicable</td>
<td>No</td>
</tr>
<tr>
<td>DM_BOOKMARK</td>
<td>No</td>
<td>VarChar</td>
<td>1024</td>
<td>No</td>
</tr>
</tbody>
</table>

The record format includes the following columns:

**DM_KEY**

An ID that uniquely identifies the bookmark block.

**DM_BOOKMARK**

A variable-length string with a maximum length of 1024 bytes. When the bookmark data is longer than 1024 bytes, the CDC Transaction stage splits the data into 1024 byte blocks. The blocks are ordered by the DM_KEY, which begins at 1. An end of bookmark record is inserted at the end of all the blocks.

**Example**

The following example demonstrates the contents of a bookmark record.

```
DM_KEY  DM_BOOKMARK
-------- -----------------------------
1 MIRROR;JOURNAL;000301000000000F646694000000000F646694000000000F646694
2
```

The following example demonstrates the contents of a bookmark record when the bookmark is split into more than one block:

```
DM_KEY  DM_BOOKMARK
-------- -----------------------------
1 MIRROR;JOURNAL;0000000000000000F646694000000000F646694000000000F646694
2 0000000000000000F646694000000000F646694000000000F646694000000000F646694
3 0000000000000000F646694000000000F646694000000000F646694000000000F646694
4 (blank to mark the last record)
```

**Important:** The actual format of the DM_BOOKMARK string varies depending on the data source and other InfoSphere CDC configuration details. The strings that are shown in these examples are used only to demonstrate the format of the bookmark record.
Configuring the CDC Transaction stage to read change data from InfoSphere CDC

The CDC Transaction stage specifies details for connecting to and reading change data from InfoSphere CDC. When you generate the template job, some of the stage properties are set to values that are accurate for the subscription. However, you must update the job to specify settings that were not known when the job was generated.

Before you begin

- Generate a template for the job
- Set up target tables for the job

Procedure

1. In the Designer client, click Import > DataStage components, and specify the path to the .dsx file that you generated. Click OK.
2. Open the job that you imported.
3. Configure the CDC Transaction stage.
   a. On the Job canvas, double-click the CDC Transaction stage.
   b. Click the Stage tab.
   c. In the Properties tab, update the following ODBC properties. These properties are used to retrieve bookmark information.

   **Bookmark DSN**
   Enter the ODBC DSN that you created for bookmark information when you configured the software for change data capture. To select from a list of available DSNs, click the Bookmark DSN button.

   **ODBC user name**
   Enter the user name that you specified for the bookmark DSN.

   **ODBC password**
   Enter the password for the ODBC user that you specified for the bookmark DSN.

   **Tip:** Click the Test link to test the ODBC connection. Clicking this link does not test the connection to the InfoSphere CDC for InfoSphere DataStage server.

   The values for other CDC Transaction stage properties are already set based on properties that are specified in the subscription.

4. Configure the output links for the CDC Transaction stage. The CDC Transaction stage includes an output link for each table in the subscription. The order of output links is not important.
   a. Click the Output tab, then select an output link.
   b. In the Properties tab, verify that the Table name field contains the name of the table that you want to replicate. Typically, you accept the value that is set for this field. If you need to change this value, specify a fully qualified table name.
   c. In the Columns tab, verify that the record format matches the format that you expect.
   d. Repeat these steps for each output link that represents a table.

5. Configure the bookmark output link. A CDC Transaction stage job can have only one bookmark link.
   a. Click the Output tab, then select the bookmark output link.
   b. In the Properties tab, in the Table name field, replace the template bookmark name, BOOKMARKTABLE, with the real name of the bookmark table. The target database must contain a unique bookmark table for each subscription. The table name can be specified with or without the schema name. If the table name is not qualified with the schema name, the schema name is...
implicitly determined by the ODBC driver or the target database. For more information about how the table name is implicitly qualified, see the documentation for ODBC or your database.

c. Optional: In the **Columns** tab, view the record format of the bookmark table.

6. Click **OK**, and then save the job.

**What to do next**

If required, add and configure additional stages. Otherwise, configure the target database stage.

**Supported data type conversions**

The data types for output links on the CDC Transaction stage are defined when you generate the InfoSphere DataStage job. However, you can change the data types on the output links from the CDC Transaction stage.

**Important:** When the CDC Transaction stage and the InfoSphere CDC for InfoSphere DataStage server communicate, they use the original data type. Be careful when you change to a data type that has a smaller precision. If the InfoSphere CDC for InfoSphere DataStage server sends a value that is out of the valid range for the data type, the job fails.

In the following tables, each row shows the original data type. An X in a column indicates that the original data type can be changed to the target data type listed in the column header. If the original data type and the target data type do not appear in the same table, then the original data type cannot be changed to the target data type. If you need to perform a data type conversion that is not allowed by the CDC Transaction stage, then perform the conversion in a downstream stage that does support the conversion.

**Table 6. Allowed data type conversions for Character data types**

<table>
<thead>
<tr>
<th>Original Type</th>
<th>NVarChar</th>
<th>VarChar</th>
<th>LongVarChar</th>
<th>LongNVARCHAR</th>
<th>NChar</th>
<th>Char</th>
</tr>
</thead>
<tbody>
<tr>
<td>NVarChar</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>NChar</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

**Table notes:**
1. Character conversion occurs from UTF-16 to the system default Character set.

**Table 7. Allowed data type conversions for Decimal data types**

<table>
<thead>
<tr>
<th>Original Type</th>
<th>Numeric</th>
<th>Decimal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

**Table 8. Allowed data type conversions for Binary data types**

<table>
<thead>
<tr>
<th>Original Type</th>
<th>LongVarBinary</th>
<th>VarBinary</th>
<th>Binary</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

**Table 9. Allowed data type conversions for Integer data types**

<table>
<thead>
<tr>
<th>Original Type</th>
<th>TinyInt</th>
<th>SmallInt</th>
<th>Integer</th>
<th>BigInt</th>
</tr>
</thead>
<tbody>
<tr>
<td>SmallInt</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Integer</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>BigInt</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
Adding and configuring additional stages

You can add stages to the job to process the change data before delivering it to the target database connector stage.

Before you begin

Configure the CDC Transaction stage

About this task

When you add stages to the job, use the following basic guidelines in the overall design of the job:

- If a subscription contains more than one table, the changes for each table can follow a different path through the job.
- To ensure transactional integrity, set all stages in the job to run sequentially.
- You can add stages to the template job. However, the job can contain no more than one CDC Transaction stage and one target database connector stage. If more than one CDC Transaction stage exists, the job fails. If more than one target database stage exists, the stages operate in separate transactions, and no transactional integrity is expected.
- Each output link from the CDC Transaction stage forms a stream of end-of-wave (EOW) markers to notify the target database connector of the commit timing. The target database connector stage commits the transaction when it receives a set of EOW markers from all the input links.
- You can split the stream by using stages that support multiple output links, such as a Filter stage or a Copy stage. You can then mix those streams at a downstream stage that supports multiple input links, such as a Funnel, Join, or Merge stage. However, do not mix a stream that originated from the CDC Transaction stage with a stream that originated from a different source. For example, some stages, such as source database stages or the Wave Generator stage, also produce EOW markers. In a CDC Transaction stage job, you do not want the EOW markers from those stages to reach the target database connector. If the extra EOW markers reach the target database connector, the transaction fails to commit as expected.
- Avoid processing data on the bookmark link. The bookmark link is used to pass bookmark information in an internal format. The bookmark link directly connects the CDC Transaction stage to the target database connector. Set the write mode on the bookmark link to "Update then insert" to overwrite the existing bookmark information on the target database connector stage.
- You can use stages that write data to external objects, such as a file or database other than the target database. However, transactional integrity is not expected for the data that is written to those external objects. If the job fails and the subscription restarts, the CDC Transaction stage re-sends the data. Duplicate data will probably be written to the external objects, but not to the target database.
• As much as possible, design the job so that workloads are equally distributed among output streams. The target stage needs to wait for the incoming data or EOW markers on all the input links. Therefore, processing heavy workloads on one of the change data streams between the CDC Transaction stage and the target stage affects the overall throughput of the job.

Procedure
1. In the Designer client palette area, open the section of the palette that contains the stage that you want to use.
2. Select the stage icon, and drag the stage to your open job.
3. Select the end of the output link from the CDC Transaction stage and drag it to the new stage.
4. Right-click the new stage and draw a link from the new stage to the next stage on the canvas.
5. Double-click the new stage, and configure it. In the Advanced tab, make sure that you select Sequential for the Execution mode. For information about configuring the stage, click Help.
6. Optional: Repeat these steps to add more stages.

What to do next
Configure the target database stage

Configuring the target database stage to write change data

When you generate the template job, it contains a DB2 connector as the target stage. If your target database is not a DB2 database, you can manually edit the job to remove the DB2 connector stage and add any supported connector type.

Before you begin
• Configure the CDC Transaction stage
• If required, add and configure additional stages

About this task
This procedure describes how to configure the target database stage. For specific configuration details, see the documentation for the connector that you are using.

Procedure
1. Configure the bookmark input link.
   a. On the Job canvas, double-click the connector stage.
   b. Click the Input tab, then select the bookmark input link in the diagram.
   c. In the Properties tab, in the Write mode field, verify that Update then insert is selected. When this option is selected, the incoming bookmark overwrites the existing one.
   d. In the Table name field, replace the template bookmark name, BOOKMARKTABLE, with the real name of the bookmark table that you created for the subscription. The target database must contain a unique bookmark table for each subscription. The table name can be specified with or without the schema name. If the table name is not qualified with the schema name, the schema name is implicitly determined by the ODBC driver or the target database. For more information about how the table name is implicitly qualified, see the documentation for ODBC or your database.
   e. Optional: In the Columns tab, view the record format of the bookmark table.
2. Configure the input links for the connector stage. The connector stage includes an input link for each table in the subscription.
   a. Click the Input tab, select the input link for a table.
In the Properties tab, in the Table name field, specify the fully qualified name of the change data table in the target database.

Specify usage properties for the input link. For more information about specifying these properties, click Help.

Optional: In the Columns tab, verify that the record format matches the format that you expect.

Repeat these steps for each input link that represents a table.

After configuring all input links, click the Link Ordering tab, and specify the order in which you want the links to execute.

3. Configure the connector stage.
   a. Click the Stage tab.
   b. In the Properties tab, specify connection details for the target database. For example, specify values for the following types of properties: Instance, Database, User name, and Password. For more information about these properties, click the Help button.
   c. Optional: After specifying connection details, click the Test link to test the connection.
   d. In the Advanced tab, verify that the value for Execution mode is Sequential. All stages in the job must run sequentially, or transactional integrity is not guaranteed.

What to do next

After configuring all stages in the job, you compile the job

Compiling the job

When you finish designing a job, compile it. Then use the log file to gather information that might help you adjust the job configuration or correct error conditions.

Procedure

1. In the Designer client, open the job that you want to compile.
2. On the toolbar, click the Compile toolbar button (or press F7).
3. If the Compilation Status area shows errors, edit the job to resolve the errors. After resolving the errors, click Re-compile.

What to do next

Start the subscription and run the job
Chapter 5. Starting the subscription and running the job

You start the subscription in the InfoSphere CDC Management Console. If auto-start is selected, starting the subscription automatically starts the InfoSphere DataStage job. If auto-start is not selected, you must start the job manually.

Before you begin

If the subscription has been running recently, verify that the previous InfoSphere DataStage job run has completed and that all data has been processed before starting the subscription. If replication begins before the previous job run has completed, the job might produce errors or fail.

Also verify that the job is compiled and that it is ready to run.

Procedure

1. Log on to the InfoSphere CDC Management Console. Specify a user ID that is authorized to run the subscription.
2. Open the Monitoring perspective.
3. In the Subscriptions tab, right-click the name of the subscription, and select one of the following replication methods:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Mirroring</td>
<td>Select this option to continuously monitor the source for updates.</td>
</tr>
<tr>
<td>Start Refresh</td>
<td>Select this option to replicate all existing data on the source to the target. This option provides a simple snapshot of the source. For more information about this option, see the InfoSphere CDC documentation.</td>
</tr>
</tbody>
</table>

4. Select one of the following options to control how the job runs:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continuous</td>
<td>Select this option to replicate continuously until the subscription is stopped. All updates are captured.</td>
</tr>
<tr>
<td>Scheduled end</td>
<td>Select this option to replicate until a specified time or location in the log is reached.</td>
</tr>
</tbody>
</table>

5. If the job is not configured to start automatically, start the job. In the IBM InfoSphere DataStage and QualityStage Designer client, open the job, and click Run. When the job is running, the links turn blue, and you can see that the row count for the bookmark link increments.

6. Optional: After changes are committed to the source database, view the data that is written to the target database. For example, for DB2 connector:
   a. In the Designer client, open the database connector stage.
   b. Select an input link that is associated with a table. In the Properties tab, click View Data. The View Data window shows all change data records that are stored in the target database table. Repeat this step to see data for other tables.

You can also run, schedule, and monitor the job in the InfoSphere DataStage and QualityStage Director client.
What to do next

Monitor the status of the job and the subscription
Chapter 6. Monitoring the status of the job and the subscription

You use the InfoSphere CDC Management Console to monitor the status of a subscription, and the InfoSphere DataStage and QualityStage Director client to monitor the status of the job. By using these tools together, you can view statistics about latency and throughput, and identify error and warning conditions.

Before you begin
Start the subscription and run the job

Procedure
1. Monitor the status of the subscription by using the InfoSphere CDC Management Console.
   a. Log on to the InfoSphere CDC Management Console. Specify a user ID that has Monitor role privileges.
   b. In the Monitoring perspective, select the Subscriptions tab.
   c. In the Subscriptions tab, select the subscription that you want to monitor.
   d. In the statistics pane, select Collect Statistics.
   e. Click one of the following icons to display the type of information that you want to view:
      - Overview
        View an overview of statistics about latency, mirroring activity, and current replication events.
      - Latency
        View the current, high, low, and average values for latency.
      - Activity
        View the current and high values for bytes per second or operations per second, and the cumulative count of bytes and operations.
      - Events
        View a list of the events that have occurred over a specific time period. Use this view to see errors and warnings about the subscription.
   For more information about monitoring subscriptions, see the InfoSphere CDC documentation.
2. Monitor the status of the job in the InfoSphere DataStage and QualityStage Director client.
   a. Log on to the Director client. If you are already logged on to InfoSphere DataStage and QualityStage Designer, select Tools > Run Director.
   b. To view the status of the job, select View > Status. To view summary information about the job, such as the number of rows updated and performance statistics, right-click the job, and select Monitor.
   c. To view the event log, select View > Log. Use this view to see errors and warnings about the job. To view details about a specific event, double-click the event in the log.
   For more information about monitoring jobs, see the IBM InfoSphere DataStage and QualityStage Director Client Guide.

What to do next
When you no longer want to replicate the source data, end the subscription.
Chapter 7. Ending the subscription

After you start a CDC Transaction stage job, it runs continuously until the subscription ends and the InfoSphere CDC for InfoSphere DataStage server sends a termination message to the CDC Transaction stage. To end the subscription, you specify one of the termination modes in the InfoSphere CDC Management Console.

Before you begin

You must have a user ID that is authorized to end the subscription.

About this task

When you end replication by using the InfoSphere CDC Management Console, the job ends gracefully. However, if a failure occurs that prevents the InfoSphere CDC for InfoSphere DataStage server and the CDC Transaction stage from communicating, there might be a delay before the InfoSphere CDC for InfoSphere DataStage server or InfoSphere DataStage recognizes that a failure has occurred. If the job ends unexpectedly, the InfoSphere CDC for InfoSphere DataStage server uses bookmark information to ensure that no data is lost when the subscription resumes.

Procedure

1. Log on to the InfoSphere CDC Management Console.
2. In the Monitoring perspective, click the Subscriptions tab.
3. In the list of subscriptions, right-click the name of the subscription, and select End Replication.
4. In the End Replication window, select one of the following methods to end replication:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Normal | InfoSphere CDC finishes in-progress work and then ends replication. If a refresh is in progress, the refresh finishes for the current table before replication ends.  

*Normal* is the most appropriate option for most business requirements and is the preferred method for ending replication in most situations. |

| Immediate | InfoSphere CDC stops all in-progress work and then ends replication. If a refresh is in progress, the refresh for the current table is interrupted and then replication ends.  

Use this option if business reasons require replication to end faster than when *Normal* is specified. Selecting this option results in a slower start time when you resume replication on the subscription.  

For the CDC Transaction stage, this method is identical to *Abort*. The CDC Transaction stage signals the other stage to stop processing. Data that is not committed on the target database is discarded. The job ends, and the log contains fatal errors. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Abort**    | InfoSphere CDC stops all in-progress work and then ends replication rapidly. If a refresh is in progress, the refresh is interrupted and the target stops processing any data that has not been committed before replication ends.  
Use this option if your business reasons require a rapid end to replication and you are willing to tolerate a much slower start time when you resume replication on the subscription.  
For the CDC Transaction stage, this method is identical to **Immediate**. The CDC Transaction stage signals the other stage to stop processing. Data that is not committed on the target database is discarded. The job ends, and the log contains fatal errors. |
| **Scheduled End** | InfoSphere CDC processes all committed changes to the indicated point in the database log and then ends replication normally.  
Use this option if your business reasons require a scheduled end to replication. |

For more information about these options, see the InfoSphere CDC documentation.

5. Click **OK**. In the list of subscriptions, the state changes to Inactive. The InfoSphere CDC for InfoSphere DataStage server sends a termination message to the CDC Transaction stage, and the job stops gracefully.
Chapter 8. Example: Applying change data by using a CDC Transaction stage

This example demonstrates how to use IBM InfoSphere Change Data Capture (InfoSphere CDC) to read changes that occur on tables in an Oracle database and then use IBM InfoSphere DataStage to replicate the changes to a target DB2 database.

When you use InfoSphere CDC to capture changes, the change data includes the before and after images of the data, along with control columns. The control columns provide additional details about the change data, such as when the change occurred and the type of operation that was performed. Depending on how replication is configured, the change data might be sent in a single record that includes the before and after images, or in multiple records.

Simply inserting the change data record into the target database might not meet your business needs. To remove the extra control columns and replicate only the change data, you can create a stored procedure and call it from the target connector stage.

Setting up source and target tables for the example

For this example, you set up a source table in an Oracle database and a target table in a DB2 database. You also create a stored procedure that is called when the target DB2 connector stage runs.

Before you begin

The log retention policy for the source database must be set to retain logs.

Procedure

1. Connect to the source Oracle database and issue the following DDL statement to create the source table, S100:

   ```sql
   create table S100 (C1 number(5), C2 VARCHAR2(10));
   ```

   If you want to use a DB2 database as the source instead of an Oracle database, modify the syntax of the create table statements, as required, and create the tables in a DB2 database.

2. Connect to the target DB2 database and issue the following DDL statement to create the target table, T100:

   ```sql
   create table T100 (C1 decimal(5), C2 varchar(10))
   ```

3. Issue the following DDL statement to create the bookmark table in the target DB2 database:

   ```sql
   create table BOOKMARKTABLE (DM_KEY smallint not null primary key, DM_BOOKMARK varchar(1024))
   ```

   **Important:** The target database must contain a unique bookmark table for each subscription. If a table with the name BOOKMARKTABLE exists in the target database, specify a different name for this table. Use this name wherever the steps in this example indicate that you must specify BOOKMARKTABLE.

4. Create the following stored procedure in the target DB2 database. You call this stored procedure from the target DB2 connector stage. The stored procedure uses the value of the DM_OPERATION_TYPE column to apply only the change data to the target table, T100:

   ```sql
   create procedure P1 (  
   IN DM_OPERATION_TYPE CHAR(1),
   IN BEFORE_C1 decimal(5),
   IN BEFORE_C2 varchar(10),
   IN AFTER_C1 decimal(5),
   ```
```sql
IN AFTER_C2 varchar(10)
)
language sql
BEGIN
DECLARE dummy INT;
DECLARE SQLSTATE CHAR(5) DEFAULT '00000';
CASE DM_OPERATION_TYPE
  WHEN 'I' THEN
    INSERT INTO T100 (C1, C2) VALUES (AFTER_C1, AFTER_C2);
  WHEN 'D' THEN
    BEGIN ATOMIC
      DECLARE CURSOR_FOR_DELETE CURSOR FOR SELECT 1 FROM T100
      WHERE C1=BEFORE_C1 AND C2=BEFORE_C2 FOR UPDATE;
      OPEN CURSOR_FOR_DELETE;
      FETCH FROM CURSOR_FOR_DELETE INTO dummy;
      IF (SQLSTATE = '00000') THEN
        DELETE FROM T100 WHERE CURRENT OF CURSOR_FOR_DELETE;
      END IF;
      CLOSE CURSOR_FOR_DELETE;
    END;
  WHEN 'U' THEN
    BEGIN ATOMIC
      DECLARE CURSOR_FOR_UPDATE CURSOR FOR SELECT 1 FROM T100
      WHERE C1=BEFORE_C1 AND C2=BEFORE_C2 FOR UPDATE;
      OPEN CURSOR_FOR_UPDATE;
      FETCH FROM CURSOR_FOR_UPDATE INTO dummy;
      IF (SQLSTATE = '00000') THEN
        UPDATE T100 SET C1=AFTER_C1, C2=AFTER_C2
        WHERE CURRENT OF CURSOR_FOR_UPDATE;
      END IF;
      CLOSE CURSOR_FOR_UPDATE;
    END;
END CASE;
END@
```

---

**Setting up replication**

You use the IBM InfoSphere Change Data Capture Management Console to add and configure a new subscription. Before you can perform these steps, the InfoSphere CDC software must be installed and configured.

**Before you begin**

Install and configure the InfoSphere CDC software.

**Procedure**

1. Log on to the InfoSphere CDC Management Console.
2. In the Access Manager perspective, add new data stores for the source and the target.
   a. Add a data store called Source to access the Oracle database.
   b. Add a data store called DataStageTarget to access InfoSphere DataStage. For example, the following image shows values that are specified for the new data store.
c. In the Connection Management tab, assign a user to each data store. In the following example, the user Admin is assigned to both data stores:

![New Datastore dialog box](image)

3. In the Configuration perspective of the InfoSphere CDC Management Console, add a subscription called ORACLECH. In the Source field, select Source. In the Target field, select DataStageTarget. For example, the following image shows values that are specified for the new subscription.

![Connection Management - Admin dialog box](image)
4. In the **Subscriptions** tab, click the subscription named ORACLECH to edit it. Right-click the subscription, and select **Map Tables** to map the table S100 to the target of the subscription, InfoSphere DataStage. When you run the wizard, make sure that you select the following options:
   a. In the Select Mapping Type page, select **InfoSphere DataStage**.
   b. In the Select InfoSphere DataStage Connection Method page, select **Direct Connect**.
   c. In the Select Source Tables page, select the table named S100 that you created earlier.
   d. In the InfoSphere DataStage Direct Connect page, select **Single Record**.

When you finish, the table mappings for the subscription are displayed in the **Table Mappings** tab.

5. In the **Subscriptions** tab, right-click the subscription, ORACLECH, and select **InfoSphere DataStage > InfoSphere DataStage Properties**. Specify the following properties:
   a. In the Direct Connect area, specify the following values for the InfoSphere DataStage job. The subscription must be open for editing when you define these properties, or your changes are not saved.
      • In the **Project Name** field, specify the name of your InfoSphere DataStage project.
      • In the **Job Name** field, specify ORACLECH.
      • In the **Connection Key** field, specify myconnectionkey.
Optional: If you want to configure the job to start automatically when the subscription starts, select Auto-start InfoSphere DataStage Job. If the check box is grayed out, the InfoSphere CDC for InfoSphere DataStage server instance is disabled for auto-start. For auto-start to be enabled, the PATH environment variable must contain the path to the dsjob executable file at the time that the instance is created.

c. Click OK.

Generating a template for the job

After you create a subscription in the InfoSphere CDC Management Console, you generate a template for the InfoSphere DataStage job.

Procedure

1. In the Subscriptions tab of the Configuration perspective, right-click the subscription, and click InfoSphere DataStage > Generate InfoSphere DataStage Job Definition. This option is available only after the subscription is correctly set up.
2. In the dialog box that is displayed, browse to select the file named ORACLECH.dsx, and click Save.
3. Copy the .dsx file to a location that is accessible by the computer where InfoSphere DataStage and QualityStage Designer is installed.
Importing and configuring the job

When you generate the template job, some of the stage properties are set to values that are accurate for the subscription. However, you must update the job to specify settings that were not known when the job was generated.

Procedure

1. In the Designer client, click **Import > DataStage components**, and specify the path to the .dsx file, for example: `C:\ORACLECH.dsx`. Click **OK**.
2. In the **Repository** area, expand **Jobs**, and double-click ORACLECH to open the job.
3. Configure the CDC Transaction stage.
   a. On the Job canvas, double-click the CDC Transaction stage.
   b. In the stage editor, select the Stage tab.
   c. In the **Properties** tab, update the following ODBC properties. These properties are used to retrieve bookmark information.

   **Bookmark DSN**
   - Enter the ODBC DSN that you created for bookmark information when you configured InfoSphere CDC.

   **ODBC user name**
   - Enter the user name that you specified for the bookmark DSN.

   **ODBC password**
   - Enter the password for the ODBC user that you specified for the bookmark DSN.

   The values for other properties are already set based on properties that are specified in the subscription. For example, the following image shows values that are specified for CDC Transaction stage properties.
d. Click OK, and then save the job.

For this example, you do not configure the CDC Transaction stage output links because they are already configured as part of the job template. Also, you do not configure the bookmark link because the table that you set up for bookmarks uses the default name that is specified in the job template.

4. Configure the DB2 connector input links.
   a. On the Job canvas, double-click the DB2 connector stage.
   b. In the stage editor select the Link tab, and then select the link named S100, from the drop-down list.
   c. In the Write mode field, select User-defined SQL.
   d. In the SQL > User-defined SQL field, select Statements.
   e. In the Statements field, enter the following procedure call:

   ```
   CALL P1(ORCHESTRATE.DM_OPERATION_TYPE,
   ORCHESTRATE.BEFORE_C1,
   ORCHESTRATE.BEFORE_C2,
   ORCHESTRATE.C1,
   ORCHESTRATE.C2)
   ```

   For example, the following image shows values that are specified for the DB2 connector input link.
f. In the **Link Ordering** tab, specify the following link order:

```
Bookmark
S100
```

You do not configure the bookmark link because the table that you set up for bookmarks uses the default name that is specified in the job template.

5. Configure the DB2 connector stage.
   a. In the stage editor, select the Stage tab.
   b. In the **Properties** tab, specify connection details for the target database. For example, specify the instance, database, user name, and password for connecting to the target database.
c. Click the Test link to test the connection. If the connection is not successful, enter the correct connection information, and try again. Click OK.

6. Click OK and then save the job.

7. Click the Compile toolbar button (or press F7). If the Compilation Status area shows errors, edit the job to resolve the errors. After you resolve the errors, click Re-compile.

Starting the subscription and running the job

You start the subscription in the InfoSphere CDC Management Console. If auto-start is selected, starting the subscription automatically starts the InfoSphere DataStage job. If auto-start is not selected, you must start the job manually.

Procedure
1. Log on to the InfoSphere CDC Management Console.
2. Open the Monitoring perspective.
3. In the Subscriptions tab, right-click the subscription named ORACLECH, and select Start Mirroring.
4. Select Continuous to replicate continuously until the subscription is stopped.
5. If the job is not configured to start automatically, start the job. In the Designer client, open the compiled job, and click Run. When the job is running, the links turn blue, and you can see that the row count for the bookmark link increments.

6. In Monitoring perspective of the InfoSphere CDC Management Console, verify that the state of the subscription is Mirror Continuous.

---

**Writing change data to the target database**

When you update the source database tables, InfoSphere CDC sends the change data to the CDC Transaction stage, which sends the change data to the target DB2 connector stage. The target DB2 connector stage then calls the stored procedure to replicate the change data to the target.

**Procedure**

1. Connect to the source database and issue the following query to update the source table, S100:
   ```sql
   insert into S100 values (1, 'FIRST');
   insert into S100 values (2, 'SECOND');
   update S100 set C2='THIRD' where C1=1;
   delete S100 where C1=2;
   ```

2. Issue the following select statement against the source database to view the data in the S100 table:
   ```sql
   select * from S100;
   ```
   The select statement returns the following data:
   ```
   C1   C2
   ------  ------
   1   THIRD
   ```

3. After changes are committed to the source database, connect to the target database, and issue the following queries to view the data in the target table:
   ```sql
   select * from T100
   ```
   The select statement returns the following data:
   ```
   C1   C2
   ------  ------
   1   THIRD
   ```

4. Issue additional queries to update, insert, and delete data. Issue select statements on the target tables to see how the change data is replicated to the target.
Chapter 9. Troubleshooting

These topics describe how to resolve problems that you might encounter when you use the CDC Transaction stage in an InfoSphere DataStage job.

Value of DM_TIMESTAMP column in the target table is incorrect

When the CDC Transaction stage inserts a timestamp into the DM_TIMESTAMP column of the target table, the value of the column might not be consistent with the expected value. The value is converted to UTC time zone before it is passed to the CDC Transaction stage.

Symptoms
An unexpected timestamp value is inserted in the DM_TIMESTAMP column of the target table.

Causes
The value of DM_TIMESTAMP is converted to UTC time zone before the InfoSphere CDC for InfoSphere DataStage server passes the value to the CDC Transaction stage.

Resolving the problem
In the InfoSphere CDC Management Console, add a system parameter to the InfoSphere CDC for InfoSphere DataStage data store that specifies the following values:

- In the Parameter name field, specify ds_output_timestamp_utc.
- In the Value field, specify false.

For more information about adding a system parameter to a data store, see the InfoSphere CDC documentation.

Job fails to start automatically

After starting a subscription in the InfoSphere CDC Management Console, the job fails to start automatically if auto-start is not correctly configured.

Symptoms
When you start a subscription in the InfoSphere CDC Management Console, the InfoSphere DataStage job that is associated with the subscription does not start.

Causes
There are multiple possible causes for this problem:

- The instance of InfoSphere CDC for InfoSphere DataStage is not running on the same computer as InfoSphere DataStage.
- The subscription might not be configured for auto-start.
- The InfoSphere CDC for InfoSphere DataStage process does not have the path or library path to the dsjob command and dependent files.
- The job is not ready to run because it has not been compiled or is in a bad state, such as DSJE_BADSTATE or DSJE_JOBLOCKED.

Resolving the problem
In the InfoSphere CDC Management Console, verify that auto-start is specified for the subscription:

1. In the Subscriptions tab, right-click the subscription, and select InfoSphere DataStage > InfoSphere DataStage Properties.
2. Verify that Auto-start InfoSphere DataStage Job is selected.
3. Verify that the correct project name and job name are specified.

If the **Auto-start InfoSphere DataStage Job** check box is grayed out, you need to recreate the instance of InfoSphere CDC for InfoSphere DataStage, making sure that the PATH environment variable contains the path to the **dsjob** command. For auto-start to work correctly, the instance must be installed on the same computer as InfoSphere DataStage.

If the check box is selected, but the job fails to start, issue the **dsjob** command manually to verify that the command starts the job successfully. Also verify that the InfoSphere CDC for InfoSphere DataStage process has the library path to the dependent shared library files for the **dsjob** command and that the process is executed by a user with the user privilege and permission to run **dsjob**. A user who is added to the primary group of the DataStage administrator has the user privilege and permission to run the **dsjob** command.

If the job does not start because it is in a bad state, perform the following steps to resolve the issue:
1. In the InfoSphere DataStage and QualityStage Director client, select **Jobs > Cleanup Resources**.
2. Stop any processes that are accessing the job.
3. Either recompile the job in the InfoSphere DataStage and QualityStage Designer client, or reset the job in the Director client. To reset the job, in the Status view, select **Job > Reset**.

### Job fails while processing large records

While running an InfoSphere DataStage job, the job fails if a record is larger than the size that is specified for a transport block in the InfoSphere DataStage parallel engine.

#### Symptoms
The job fails with an error message that indicates that the record is too big to fit in a block.

#### Causes
The job needs to pass each record in a single transport block. However, the job is attempting to pass a record that is larger than the size of the transport block that InfoSphere DataStage can pass between the stages of a job. The size of the transport block is specified by the APT_DEFAULT_TRANSPORT_BLOCK_SIZE environment variable. By default, the value of this environment variable is 128 KB.

#### Resolving the problem
Increase the value of the APT_DEFAULT_TRANSPORT_BLOCK_SIZE environment variable to a size that is larger than the largest record that you need to transfer between the stages of the job. Note that increasing the value of this environment variable affects all links and might increase overall memory and disk usage. For more information, see the IBM *InfoSphere DataStage and QualityStage Parallel Job Advanced Developer’s Guide*.

**Tip:** If the source tables have LOB data type columns, consider specifying a larger value for the **Large Object Truncation Size** property in the InfoSphere DataStage Properties window of the InfoSphere CDC Management Console.

### Job fails with authentication failure message

While running an InfoSphere DataStage job, the job fails if the CDC Transaction stage cannot authenticate with the InfoSphere CDC for InfoSphere DataStage server.

#### Symptoms
The CDC Transaction stage fails with an error message that indicates that authentication has failed.

#### Causes
The CDC Transaction stage properties that are used for authentication are not specified or are specified incorrectly.

**Resolving the problem**
In the Properties tab of the CDC Transaction stage, specify the correct values for the Subscription and Connection key properties.

---

**Job fails with bookmark table missing message**
While running an InfoSphere DataStage job, the job fails if the InfoSphere CDC for InfoSphere DataStage server cannot write bookmark information to the bookmark table.

**Symptoms**
The CDC Transaction stage fails with a message that indicates that the bookmark table is missing.

**Causes**
The InfoSphere CDC for InfoSphere DataStage server cannot write bookmark information to the bookmark table because the table does not exist. The table might have been deleted after the subscription started.

**Resolving the problem**
Create the bookmark table on the target database, and then restart the subscription and job.

---

**Job fails with connection error message**
While running an InfoSphere DataStage job, the job fails if the CDC Transaction stage is unable to connect to the InfoSphere CDC for InfoSphere DataStage server.

**Symptoms**
The job fails with an error message that indicates that the connection to the InfoSphere CDC for InfoSphere DataStage server failed.

**Causes**
The CDC Transaction stage failed to connect to server’s listening port that is specified in the Host name and Port number stage properties for the CDC Transaction stage.

**Resolving the problem**
Verify that the InfoSphere CDC for InfoSphere DataStage server is running on the host name and port number that are specified in the stage properties for the CDC Transaction stage.

---

**Job fails with multiple bookmark links or no bookmark link error message**
While running an InfoSphere DataStage job, the job fails if the CDC Transaction stage finds multiple bookmark links or no bookmark link.

**Symptoms**
The job fails with an error message that indicates that either multiple bookmark links exist, or that no bookmark link is defined.

**Causes**
The CDC Transaction stage requires one and only one bookmark link. The job fails if more than one link is specified as the bookmark link, or if no links are specified as the bookmark link.

**Resolving the problem**
In the stage editor for the CDC Transaction stage, modify the link properties to ensure that one and only one link is specified as the bookmark link. To specify that a link is the bookmark link, set the Bookmark link property to Yes.

---

**Job fails with table name for subscription not specified on link error message**

While running an InfoSphere DataStage job, the job fails if the CDC Transaction stage cannot find the link that is required to transfer the data for a source table.

**Symptoms**
The job fails with an error message that indicates that the table name for the subscription is not specified in the link property.

**Causes**
The CDC Transaction stage cannot find the link to transfer the data for the source table because the Table name property for one or more output links is not correctly specified.

**Resolving the problem**
In the stage editor for the CDC Transaction stage, select the output link, and specify the correct value for the Table name property.

---

**Job fails with no response from server error message**

While running an InfoSphere DataStage job, the job fails if the CDC Transaction stage does not receive a response from the InfoSphere CDC for InfoSphere DataStage server.

**Symptoms**
The job fails with an error message that indicates that no response was returned from the InfoSphere CDC for InfoSphere DataStage server.

**Causes**
The CDC Transaction stage and the server were able to establish a session, but the CDC Transaction stage failed to receive data within the timeout period. If this error occurs at the beginning a job, the subscription might not be started correctly in the InfoSphere CDC Management Console. This error might occur when the job is started manually, but the subscription is not started, and no data flows from the server. This error might also be caused by a server-side issue or network issues.

**Resolving the problem**
In the InfoSphere CDC Management Console, view the subscription status and the event log. If the subscription is not started, start it. Also check the health of the network connection between the server computer and the computer where the CDC Transaction stage runs.

---

**Job fails with ODBC access failure message**

While running an InfoSphere DataStage job, the job fails if the CDC Transaction stage cannot use ODBC to access the target database.

**Symptoms**
The CDC Transaction stage fails with a message that indicates that ODBC access has failed.

**Resolving the problem**
In the Properties tab of the CDC Transaction stage, verify that the correct values are specified for the following stage properties: Bookmark DSN, ODBC user name, and ODBC password. Click the Test link to verify that these connection parameters are correct.
**Output data is truncated**
The data that is output from InfoSphere CDC is truncated before it is written to the CDC Transaction stage.

**Symptoms**
The data that is output from InfoSphere CDC is unexpectedly truncated at some length.

**Causes**
If you are replicating LOB data, the data is truncated at the value specified for the Large Object Truncation Size property in the InfoSphere DataStage Properties window of the InfoSphere CDC Management Console.

**Resolving the problem**
Define a larger truncation size for LOB data. Specify a large enough value so that the total length of the output record does not exceed the size of the transport block that can pass between the stages of a job. The size of the transport block is specified by the APT_DEFAULT_TRANSPORT_BLOCK_SIZE environment variable. By default, the value of this environment variable is 128 KB. You can increase the size of the transport block. However, increasing this size affects all links and might increase overall memory and disk usage.

---

**Subscription stops while still in "Starting" state**
After starting a subscription in the InfoSphere CDC Management Console, the state does not progress as expected if the CDC Transaction stage fails to get a connection to the InfoSphere CDC for InfoSphere DataStage server.

**Symptoms**
The status of the subscription in the InfoSphere CDC Management Console does not progress beyond the “Starting” state.

**Causes**
The InfoSphere CDC for InfoSphere DataStage server is waiting for the connection from the CDC Transaction stage.

**Resolving the problem**
In the Properties tab of the CDC Transaction stage, verify that the values specified for Host name and Port number are correct. Also verify that the connection details specified for the bookmark DSN are correct.
Chapter 10. Frequently asked questions about the CDC Transaction stage

Find the answers to frequently asked questions about using the CDC Transaction stage in an InfoSphere DataStage job.

“Does the bookmark table need to be created for each subscription?”

Yes. The bookmark table should be accessed from only one job. Other applications should not access the bookmark table while the subscription is running.

“How do I see all the properties in the stage editor?”

Click the link or the stage tab to see properties for each category. The properties that are displayed vary depending on whether you select the stage or the link tabs.

“What are the columns that are prefixed with "DM_" in the generated job?”

These columns contain replication-related metadata that is provided by InfoSphere CDC or the CDC Transaction stage. You can use the data in these columns, or you can drop the columns if the design of your job or business logic does not require them. For more information about these columns, see the topic that describes the record format for change data records.

“What do I do if the generated job does not compile successfully?”

Edit the job and specify values for all required properties before you compile the job. You must specify values for the following properties in the Properties tab of the CDC Transaction stage:

- Host name
- Port number
- Subscription

“Why can’t I change the execution mode from Sequential to Parallel in the stage editor?”

“Why does the Test link succeed even though the wrong host name or port number is specified?”

“Why does the Bookmark DSN button show the correct DSN?”

“Why is the subscription name truncated in the stage property value when InfoSphere CDC Management Console generates the job template?”
When you generate the job, the InfoSphere CDC Management Console sets predefined default values for the following CDC Transaction stage properties. You usually need to update the values for these properties:

- **Bookmark DSN**
- **ODBC user name**
- **ODBC password**
- **Table name** for the bookmark link.

**What is the heartbeat interval, and do I need to configure it?**

The answer to this question depends on your computing environment, especially the network that used by InfoSphere CDC and the CDC Transaction stage to communicate. A heartbeat is a virtual message between InfoSphere CDC and the CDC Transaction stage. The heartbeat is used to keep the network connection alive. You specify a value in seconds for the heartbeat interval that accurately reflects the time interval during which you are sure that the network connection is kept alive. During this time interval, InfoSphere CDC and the CDC Transaction stage attempt to keep the session alive by sending a packet.

**Why can't I change the execution mode from Sequential to Parallel in the stage editor?**

To ensure transactional integrity, the CDC Transaction stage runs in sequential mode only.

**Why does the Test link succeed even though the wrong host name or port number is specified?**

When you click the **Test** link for testing connection parameters in the CDC Transaction stage, only the parameters for accessing the target database through ODBC are tested. These connection properties are specified in the **Bookmark DSN**, **ODBC user name**, and **ODBC password** fields.

**Why doesn't the Bookmark DSN button show the correct DSN?**

The ODBC DSN that you want to use is not correctly configured. For more information, see the topic about setting up the ODBC data source for bookmark information.

**Why is the subscription name truncated in the stage property value when InfoSphere CDC Management Console generates the job template?**

The CDC Transaction stage and InfoSphere CDC for InfoSphere DataStage use only the first eight characters of the subscription name that is specified in the InfoSphere CDC Management Console. Therefore, the name is truncated when the job is generated.
Chapter 11. Environment variables: CDC Transaction stage

The InfoSphere CDC Transaction stage uses these environment variables.

**CC_CDC_DEBUG**

Set this connector environment variable to gather debugging information.

When this environment variable is set to **ALL**, the CDC Transaction stage sends debugging information to the job log.

**CC_CDC_SIMULATE_SOCKET**

Set this environment variable to collect the communication data from the CDC server.

When the value of this variable is set to 1, CDC transaction stage reads the test.dat file located in the project directory and simulates as if it communicates with the CDC server. When the value of this variable is set to 2, the CDC Transaction stage sends data from the CDC server to test.dat file.

**CC_IGNORE_TIME_LENGTH_AND_SCALE**

Set this environment variable to change the behavior of the connector on the parallel canvas.

When this environment variable is set to 1, the connector running with the parallel engine ignores the specified length and scale for the timestamp column. For example, when the value of this environment variable is not set and if the length of the timestamp column is 26 and the scale is 6, the connector on the parallel canvas considers that the timestamp has a microsecond resolution. When the value of this environment variable is set to 1, the connector on the parallel canvas does not consider that the timestamp has a microsecond resolution unless the microseconds extended property is set even if the length of the timestamp column is 26 and the scale is 6.

**CC_MSG_LEVEL**

Set this environment variable to specify the minimum severity of the messages that the connector reports in the log file.

At the default value of 3, informational messages and messages of a higher severity are reported to the log file.

The following list contains the valid values:

- 1 - Trace
- 2 - Debug
- 3 - Informational
- 4 - Warning
- 5 - Error
- 6 - Fatal
Appendix A. Product accessibility

You can get information about the accessibility status of IBM products.

The IBM InfoSphere Information Server product modules and user interfaces are not fully accessible. The installation program installs the following product modules and components:
- IBM InfoSphere Business Glossary
- IBM InfoSphere Business Glossary Anywhere
- IBM InfoSphere DataStage
- IBM InfoSphere FastTrack
- IBM InfoSphere Information Analyzer
- IBM InfoSphere Information Services Director
- IBM InfoSphere Metadata Workbench
- IBM InfoSphere QualityStage

For information about the accessibility status of IBM products, see the IBM product accessibility information at [http://www.ibm.com/able/product_accessibility/index.html](http://www.ibm.com/able/product_accessibility/index.html).

Accessible documentation

Accessible documentation for InfoSphere Information Server products is provided in an information center. The information center presents the documentation in XHTML 1.0 format, which is viewable in most Web browsers. XHTML allows you to set display preferences in your browser. It also allows you to use screen readers and other assistive technologies to access the documentation.

The documentation that is in the information center is also provided in PDF files, which are not fully accessible.

IBM and accessibility

See the [IBM Human Ability and Accessibility Center](http://www.ibm.com/able/) for more information about the commitment that IBM has to accessibility.
Appendix B. Reading command-line syntax

This documentation uses special characters to define the command-line syntax.

The following special characters define the command-line syntax:

[ ] Identifies an optional argument. Arguments that are not enclosed in brackets are required.

... Indicates that you can specify multiple values for the previous argument.

\ Indicating mutually exclusive information. You can use the argument to the left of the separator or the argument to the right of the separator. You cannot use both arguments in a single use of the command.

{} Delimits a set of mutually exclusive arguments when one of the arguments is required. If the arguments are optional, they are enclosed in brackets ([ ]).

Note:

- The maximum number of characters in an argument is 256.
- Enclose argument values that have embedded spaces with either single or double quotation marks.

For example:

```
 wsetsrc [-S server] [-l label] [-n name] source
```

The source argument is the only required argument for the wsetsrc command. The brackets around the other arguments indicate that these arguments are optional.

```
 wlsac [-l | -f format] [key ... ] profile
```

In this example, the -l and -f format arguments are mutually exclusive and optional. The profile argument is required. The key argument is optional. The ellipsis (...) that follows the key argument indicates that you can specify multiple key names.

```
 wrb -import [rule_pack | rule_set]...
```

In this example, the rule_pack and rule_set arguments are mutually exclusive, but one of the arguments must be specified. Also, the ellipsis marks (...) indicate that you can specify multiple rule packs or rule sets.
Appendix C. How to read syntax diagrams

The following rules apply to the syntax diagrams that are used in this information:

- Read the syntax diagrams from left to right, from top to bottom, following the path of the line. The following conventions are used:
  - The >>--- symbol indicates the beginning of a syntax diagram.
  - The ---> symbol indicates that the syntax diagram is continued on the next line.
  - The >--- symbol indicates that a syntax diagram is continued from the previous line.
  - The --->< symbol indicates the end of a syntax diagram.
- Required items appear on the horizontal line (the main path).

- Optional items appear below the main path.

If an optional item appears above the main path, that item has no effect on the execution of the syntax element and is used only for readability.

- If you can choose from two or more items, they appear vertically, in a stack.
  - If you must choose one of the items, one item of the stack appears on the main path.
  - If choosing one of the items is optional, the entire stack appears below the main path.
  - If one of the items is the default, it appears above the main path, and the remaining choices are shown below.

- An arrow returning to the left, above the main line, indicates an item that can be repeated.

If the repeat arrow contains a comma, you must separate repeated items with a comma.
A repeat arrow above a stack indicates that you can repeat the items in the stack.

- Sometimes a diagram must be split into fragments. The syntax fragment is shown separately from the main syntax diagram, but the contents of the fragment should be read as if they are on the main path of the diagram.

Fragment-name:

- Keywords, and their minimum abbreviations if applicable, appear in uppercase. They must be spelled exactly as shown.
- Variables appear in all lowercase italic letters (for example, column-name). They represent user-supplied names or values.
- Separate keywords and parameters by at least one space if no intervening punctuation is shown in the diagram.
- Enter punctuation marks, parentheses, arithmetic operators, and other symbols, exactly as shown in the diagram.
- Footnotes are shown by a number in parentheses, for example (1).
Appendix D. Contacting IBM

You can contact IBM for customer support, software services, product information, and general information. You also can provide feedback to IBM about products and documentation.

The following table lists resources for customer support, software services, training, and product and solutions information.

Table 12. IBM resources

<table>
<thead>
<tr>
<th>Resource</th>
<th>Description and location</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM Support Portal</td>
<td>You can customize support information by choosing the products and the topics that interest you at <a href="http://www.ibm.com/support/entry/portal/Software/Information_Management/InfoSphere_Information_Server">www.ibm.com/support/entry/portal/Software/Information_Management/InfoSphere_Information_Server</a></td>
</tr>
<tr>
<td>Software services</td>
<td>You can find information about software, IT, and business consulting services, on the solutions site at <a href="http://www.ibm.com/businesssolutions/">www.ibm.com/businesssolutions/</a></td>
</tr>
<tr>
<td>My IBM</td>
<td>You can manage links to IBM Web sites and information that meet your specific technical support needs by creating an account on the My IBM site at <a href="http://www.ibm.com/account/">www.ibm.com/account/</a></td>
</tr>
<tr>
<td>Training and certification</td>
<td>You can learn about technical training and education services designed for individuals, companies, and public organizations to acquire, maintain, and optimize their IT skills at <a href="http://www.ibm.com/software/sw-training/">http://www.ibm.com/software/sw-training/</a></td>
</tr>
<tr>
<td>IBM representatives</td>
<td>You can contact an IBM representative to learn about solutions at <a href="http://www.ibm.com/connect/ibm/us/en/">www.ibm.com/connect/ibm/us/en/</a></td>
</tr>
</tbody>
</table>
Appendix E. Accessing and providing feedback on the product documentation

Documentation is provided in a variety of locations and formats, including in help that is opened directly from the product client interfaces, in a suite-wide information center, and in PDF file books.

The information center is installed as a common service with IBM InfoSphere Information Server. The information center contains help for most of the product interfaces, as well as complete documentation for all the product modules in the suite. You can open the information center from the installed product or from a Web browser.

Accessing the information center

You can use the following methods to open the installed information center.

• Click the Help link in the upper right of the client interface.

  Note: From IBM InfoSphere FastTrack and IBM InfoSphere Information Server Manager, the main Help item opens a local help system. Choose Help > Open Info Center to open the full suite information center.

• Press the F1 key. The F1 key typically opens the topic that describes the current context of the client interface.

  Note: The F1 key does not work in Web clients.

• Use a Web browser to access the installed information center even when you are not logged in to the product. Enter the following address in a Web browser: http://host_name:port_number/infocenter/topic/com.ibm.swg.im.iis.productization.iisinfsv.home.doc/ic-homepage.html. The host_name is the name of the services tier computer where the information center is installed, and port_number is the port number for InfoSphere Information Server. The default port number is 9080. For example, on a Microsoft® Windows® Server computer named iisdocs2, the Web address is in the following format: http://iisdocs2:9080/infocenter/topic/com.ibm.swg.im.iis.productization.iisinfsv.nav.doc/dochome/iisinfsrv_home.html.

A subset of the information center is also available on the IBM Web site and periodically refreshed at http://pic.dhe.ibm.com/infocenter/iisinfsv/v9r1/index.jsp.

Obtaining PDF and hardcopy documentation

• A subset of the PDF file books are available through the InfoSphere Information Server software installer and the distribution media. The other PDF file books are available online and can be accessed from this support document: https://www.ibm.com/support/docview.wss?uid=swg27008803&wv=1

• You can also order IBM publications in hardcopy format online or through your local IBM representative. To order publications online, go to the IBM Publications Center at http://www.ibm.com/e-business/linkweb/publications/servlet/pbi.wss.

Providing comments on the documentation

Your feedback helps IBM to provide quality information. You can use any of the following methods to provide comments:

• To comment on the information center, click the Feedback link on the top right side of any topic in the information center.

• Send your comments by using the online readers’ comment form at www.ibm.com/software/awdtools/rcf/
• Send your comments by e-mail to comments@us.ibm.com. Include the name of the product, the version number of the product, and the name and part number of the information (if applicable). If you are commenting on specific text, include the location of the text (for example, a title, a table number, or a page number).
• You can provide general product feedback through the Consumability Survey at [http://www.ibm.com/software/ucd/consumability/]
Notices and trademarks

This information was developed for products and services offered in the U.S.A.

Notices

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.
Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
J46A/G4
555 Bailey Avenue
San Jose, CA 95141-1003 U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information is for planning purposes only. The information herein is subject to change before the products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs. © Copyright IBM Corp. _enter the year or years_. All rights reserved.
If you are viewing this information softcopy, the photographs and color illustrations may not appear.

**Trademarks**

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at [www.ibm.com/legal/copytrade.shtml](http://www.ibm.com/legal/copytrade.shtml).

The following terms are trademarks or registered trademarks of other companies:

Adobe is a registered trademark of Adobe Systems Incorporated in the United States, and/or other countries.

Intel and Itanium are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft, Windows and Windows NT are trademarks of Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.

The United States Postal Service owns the following trademarks: CASS, CASS Certified, DPV, LACS\textsuperscript{Link}, ZIP, ZIP + 4, ZIP Code, Post Office, Postal Service, USPS and United States Postal Service. IBM Corporation is a non-exclusive DPV and LACS\textsuperscript{Link} licensee of the United States Postal Service.

Other company, product or service names may be trademarks or service marks of others.
Index

Special characters
.dsx files
  generating for CDC Transaction stage jobs 17

A
Access to ODBD data sources
  configuring 10
authentication
  troubleshooting failures 44
autostart
  troubleshooting 43

B
bookmarks
  CDC Transaction stage properties 22
  creating tables for 18
  record format 21
  troubleshooting failures 45

C
CC_CDC_DEBUG environment variable 51
CC_CDC_SIMULATE_SOCKET environment variable 51
CC_CDC_SIMULATION_FILE environment variable 51
CDC Transaction stage
  configuration 22
  overview 1, 2
CDC Transaction stage jobs
  additional stages 24
  compiling 26
  data flow 2
  data type conversions 23
  development steps 17
  example 33
  frequently asked questions 49
  generating templates 17
  guidelines for job design 24
  limitations 4
  monitoring 29
  software prerequisites 4
  starting 27
  supported installation topologies 4
  target database stage configuration 25
  target table setup 18
  troubleshooting 43
change data capture (continued)
  record format 18
  setup 15
  target table setup 18
  command-line syntax
    conventions 55
    commands
      syntax 55
    connections
      troubleshooting failures 45
    customer support
      contacting 59

D
data types
  supported conversions 23
  DM_BOOKMARK column 21
  DM_KEY column 21
  DM_OPERATION_TYPE column 18
  DM_SORTKEY column 18
  DM_TIMESTAMP column 18
  DM_TXID column 18
  DM_USER column 18
  dsenv script 12

E
encryption
  support in CDC Transaction stage 4
environment variables
  InfoSphere Change Data Capture 51
examples
  CDC Transaction stage jobs 33

F
frequently asked questions
  CDC Transaction stage jobs 49

I
InfoSphere CDC
  CDC Transaction stage questions 49
  configuring instances 9
  ending subscriptions 31
  overview 1, 2
  software installation topologies 5
  starting subscriptions 27

L
large records
  troubleshooting failures 44
legal notices 63
LOB data
  troubleshooting truncation 47
  truncation in CDC Transaction stage 4

M
multiple record format 18

O
ODBC
  CDC Transaction stage failures 46
  ODBC databases
    setting up connectivity 10
  ODBC password
  ODBC user name
  CDC Transaction stage 22
overview
  InfoSphere CDC 1, 2

P
parallel engine
  connecting to ODBC databases 10
product accessibility
  accessibility 53
product documentation
  accessing 61

R
record format
  bookmarks 21
  change data capture columns 18
  multiple record 18
  single record 18
replication
  CDC Transaction stage installation topologies 5
  CDC Transaction stage prerequisites 4
  CDC Transaction stage questions 49
  ending 31
  InfoSphere DataStage job development 17
  setting up 15
  starting 27
  supported installation topologies 4
  target table setup 18

S
setting environment variables for databases
  setting 11, 12
  single record format 18
software services
  contacting 59
special characters
  in command-line syntax 55
subscriptions
  ending 31
  setting up 15
subscriptions (continued)
  starting 27
  troubleshooting 47
support
  customer 59
syntax
  command-line 55

T
  tables
    mapping for InfoSphere CDC 15
    troubleshooting table name errors 46
  templates
    generating for CDC Transaction stage jobs 17
trademarks
  list of 63
transactional integrity
  CDC Transaction stage 4
troubleshooting
  authentication failures 44
  autostart fails 43
  CDC Transaction stage jobs 43
  connection failure 45
  missing bookmark tables 45
  multiple or no bookmark links error 45
  ODBC access failures 46
  table name not specified error 46
  too big for block error 44
  truncated LOB data 47

W
  web sites
    non-IBM 57